1. OneNote basics

 

How are OneNote pages different?

This is an example of a normal page of notes. You can type anywhere — just click and type. For example, type your name here. Then try moving it around.
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What are all the tabs?

OneNote is a place for gathering, organizing, searching, and sharing notes, clippings, thoughts, reference materials, and other information. All your notes will be visible here — organized by notebooks, sections, and pages. You can create them by clicking File > New.

	Notebooks:
Start with one or two.
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	Sections in the current notebook:
Sections let you organize notes by activities, topics, or people in your life. Start with a few in each notebook.

[image: image3.png]



	Pages in the current section:
Create as many note pages in each section as you want.
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Special Unfiled Notes section — for note pages you need to create in a hurry. You can drag them elsewhere later.

	[image: image6.png]



	 
There is no Save button on the toolbar because OneNote saves all your notes automatically!


How can OneNote help me?

Take a few minutes to learn more about OneNote and its most important features.
Flip through the page tabs in this section (on the right-hand side):
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Upgrading from OneNote 2003? Make sure to check out page 11 after you have looked through the other pages.
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2. How can OneNote help me?

 

Something for everyone

OneNote is an idea processor, a notebook, an information organizer — some even call it an "add-on pack for your brain". Many people find OneNote indispensible once they start using it and we hope you do too! 
OneNote can help if you need to:

· Make sure you don't lose any information that you think is important
· Organize scraps of information that don't fit well into e-mail, calendar, or formal documents
· Gather and refer back to notes from meetings or lectures
· Collect research from the Web or other sources and annotate it for yourself or others
· Keep track of what you need to do next and not miss anything
· Work closely with other people on a project sharing notes and files
OneNote will complement your activities in Microsoft® Office Outlook®, Word, and other programs in the Microsoft Office system through several integration features.

Capture ideas and gather information

You can quickly capture meeting notes, brainstorming notes, ideas and thoughts, audio from discussions, video from interviews, diagrams, and so on using the keyboard, pen or the recording capabilities in OneNote. You can also gather clippings from the Web, e-mail, miscellaneous materials for projects, customers, and classes, files, pictures, and so on using convenient integration with your Web browser and the Office system.

Keep things organized

With OneNote, all this information stays in one place. It is easy to organize it, or pile it together  (if that’s your preference), and then search and find it again — even words in pictures and audio or video recordings! Since OneNote uses the familiar concept of notebooks divided into sections with pages, you can get going right away.
Be prepared

Having all this information at your fingertips will keep you always prepared: for the next meeting, for writing a final document or e-mail message, for doing a task, for talking to a customer, for going on a trip, and so on. You can flag items in your notebooks as Important or To Do and then quickly gather summaries of information you have flagged this way. OneNote is fully customizable so you can adapt it to your work style.

A team effort

You can also work with your whole team — in a shared notebook that everybody can edit at the same time and view even while not connected to the network. OneNote seamlessly merges the changes each time anyone updates the notebook. A shared notebook is a great way to see what information the team has gathered, what files and notes are available as sources, even what action items remain for the team to work on.

 

Continue to the next pages of this Guide for an overview of basic features you should know about.
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3. Take notes of many types

 

Move your mouse over each note

You can take notes from top to bottom like in a word processor or use the whole page to arrange things as they make sense to you. When you take notes all over the page, they end up in separate note containers that you can move around. Try dragging the note containers using the handle at the top of each container. Press SHIFT while dragging if you want to merge the containers.

You can store information in tables.
	Food to bring
	Quantity

	Apples
	5

	Oranges
	4

	Drinks
	8


You can paste pictures into your notes, including clip art and digital photos
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It's easy to create lists:
· Bulleted lists for random thoughts
· In many different styles
· Even nested outlines
 

1. Create numbered lists

2. Use them for step-by-step notes

Innnotes

 

For ink tips on Tablet PC, check the More Cool Features section after you are done with this one.

 

You can make simple diagrams using the Drawing Toolbar (available on the View menu).

You can copy and paste information from the Web or from other programs on your computer.
	[image: image19.jpg]!‘g





	Products
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Team Ball

100% Leather

$49.99
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Team Bag

Lightweight, waterproof

Price: $49.99



Pasted from  <http://www.contoso.com>
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4. Gather screen clippings

 

Capture screenshots of what you see on the Web or in programs that you work with. Screen clippings are especially useful for Web research, trip planning, online shopping, and product comparisons.

Try it now

Insert a screen clipping from the Web:
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	Press Window logo key + S while in any program or browser


 

1. Select an area of your screen. A separate OneNote window will open showing the Unfiled Notes section where the screen clipping is inserted:
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When you want to insert a screen clipping into the current page instead of the Unfiled Notes section, switch to the OneNote window, put the cursor where you want the clipping, and click Insert > Screen Clipping or the Clip button on the toolbar:
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You can customize options for screen clippings by right-clicking the OneNote icon in the Windows taskbar:
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5. How to organize notes

 

Start with one or two notebooks

You can start with the Work and Personal notebooks that are already created in OneNote and modify them as you like. Or you can close these notebooks and create a new notebook. Click File > New > Notebook to open the New Notebook Wizard. Try using one of the notebook templates listed in the wizard.
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Create sections by project or topic 
If your activities revolve around a project, a topic, or a class, create a section for each of these items in your notebook.
[image: image35.png]



 

Create sections by person or customer

If you mostly deal with customers, patients, clients, or your direct reports, create a section for each of them.
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Use the Unfiled Notes section when in doubt

When you don't have time to think about where your notes should go, just click Window logo key + N which immediately launches OneNote and creates a new page in the Unfiled Notes section (click the button at the bottom of the Navigation Bar to jump to it later). It's okay if this section gets big. You can drag the pages to other sections later, or just use search to find them in this section.
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Change your organization over time

As you use OneNote and create more notes, you may want to organize your notes differently:

· If you find yourself creating a lot of pages for a topic, try dragging them into a new section
· If you find yourself creating many sections in one notebook, try putting some of them into a separate notebook
· Make navigation between notes more convenient by creating several notebooks at the top level, rather than putting everything inside one notebook
When you need to reorganize your notes, you may find it convenient to expand the Navigation Bar:
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Note that in Windows Explorer:

· Notebooks are regular folders
· Sections are regular files
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If you accumulate too many notebooks with too many sections inside each notebook, you can use Section Groups (File > New > Section Group) to nest a multi-level hierarchy of sections within one notebook.
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6. Search your notes

 

OneNote can quickly find typed text, handwritten notes (if they were written on a Tablet PC), and even text inside pictures!

Try it now! Search for the word "Contoso"

Use the search box in the top right side of the OneNote window to type the text you are looking for, and then press ENTER or click the Search button. You can also press CTRL + F to jump to the search box.
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	When the search results appear, you can view each search result individually, or click View List to see a complete list of the pages that contain your search term.


Tip: Click the red X button when you want to clear the yellow highlighting.

 

Did OneNote find the word in the picture of the business card below?

 

Main contact in Contoso: Rene Valdes
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7. Work with Outlook

In Outlook:
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In Outlook 2007 this button is also available on the right-click menu for an item, or on the ribbon when you open the item:
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Microsoft® Office Outlook® 2003 or 2007 required.
 

Create Outlook tasks from OneNote

In OneNote, mark follow up items from meetings or brainstorming notes as Outlook tasks.
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	Use the Task toolbar button and drop-down or Insert > Outlook Task. Click the drop-down arrow to control the task due date.
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Changes in Outlook and OneNote are synchronized:
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Create linked notes for Outlook meetings and Contacts

In Outlook, select a meeting or contact in Outlook that you want to take notes about.
Click the OneNote button with a chain link to create the linked notes.
Later click the button again to open the created notes in OneNote.
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Send e-mail messages to OneNote

In Outlook, select an e-mail message and send it to OneNote. 
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By default, the message goes to the Unfiled Notes section, but you can change that setting in Tools > Options > Outlook Integration.

E-mail notes directly from OneNote

Read the next page of the Guide to find out about this feature.

1

 

3  Task will appear in Outlook 
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8. Send notes to others

 

E-mail notes, even to those who don't have OneNote

You can send any note page as an e-mail message, directly from OneNote. For example, send your meeting notes to other meeting participants. Recipients don't need to have OneNote to view the notes, because the notes are placed into the body of the message in HTML format, or added as an HTML attachment. 
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	Click the E-mail toolbar button or click File > E-mail to compose a message.
(You can click the E-mail button again if you want to cancel composing a message)


Note: This feature works best with Outlook 2007. It will also work with most other Windows-based e-mail programs if they properly support the MAPI interface.

 

Publish notes as PDF

	Note: 
	You can save as a PDF or XPS file only after you install an add-in. For more information, see Install and use a PDF or XPS add-in.


You can save your notes in formats like PDF of XPS, for distributing to people who do not have OneNote or posting your notes on a Web page.

You can publish selected page(s) or a whole section. Click File > Publish as PDF or XPS.
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9. Tag important notes

 

Use Tags to easily find important items buried in your notes. To see tags from all notebooks, click View > All Tagged Notes.

Tag meeting decisions, ideas, definitions, key points, billable hours, questions, people's names, books to read, etc. If you don't have Outlook for task management, you can use check-box tags to track tasks.

Try it now:

1. Put your cursor on the line below:
Important decision in a meeting
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	Find the Tag toolbar button and click the drop-down arrow. Or click Insert > Tag.


Click Important on the drop-down menu:
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2. On the same drop-down menu click Show All Tagged Notes. You will see the tagged note in the list, in addition to tags from other notebooks. Click on any tag in the roll-up to jump to the note.
 

Tip: If you want to limit the tags summary to part of your notes, or just see notes you have tagged recently, choose a different Search setting at the bottom of the Tags Summary task pane:
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Customize your tags

You can customize your tags however you want using Customize My Tags at the bottom of the drop-down menu. If you use OneNote at work, you can create tags that match your occupation. Similarly, students can use tags that are keyed to specific academic tasks.

Sample set of tags for students:
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10. Use shared notebooks

 

Better than a document on a file share or shared drive

With a shared notebook:

· Multiple people can edit it at the same time
· Changes are merged automatically
· Notebook is available offline for each person
 

Keep your team "on the same page"

You can use a shared notebook for notes about a team project,
so that everyone can work on it at once, like in a wiki — only better. 
Shared notebooks are great for storing:

· Meeting notes
· Project vision and brainstorming ideas
· Any supporting materials collected by group members
· List of team work items that people can mark off. (If you manage your work items in Microsoft® Office Project, you can drag the project file onto a OneNote page as an attachment)
· Informal draft of the project report where people can add comments. Later you can send it to Microsoft® Office Word (File > Send To)
 

A notebook can be shared simply by storing it in a shared location, such as a shared folder on your own computer, a file share on a server, or SharePoint site (Microsoft® Windows® SharePoint® Services 2.0 or 3.0). OneNote will guide you through setting up a proper location if you use the Share menu or the shared notebook option in the New Notebook Wizard.
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Best practices for Shared Notebooks

To discover the best ways to use a notebook with a group of people, try the Shared Notebook templates when you create a Shared Notebook in the New Notebook Wizard.
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11. Upgrading from OneNote 2003?

 

What you need to know about the new file format

When you started OneNote 2007, your notes were upgraded to the new file format. The upgraded copy is placed in the new OneNote Notebooks folder. Your My Notebook folder remains untouched.

	Can I upgrade later?
	You can upgrade individual notes by clicking the information bar at the top of the page:
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If you don't upgrade:

· Earlier version notes will be read-only
· Some functionality (for example, search) is not fully supported for such notes 

	Don't upgrade shared notes
	If you are sharing OneNote 2003 files with other people who do not have OneNote 2007, do not upgrade those files. 
OneNote 2003 cannot read the new OneNote 2007 format.

	Notebooks vs. folders
	If you did a bulk upgrade, be aware that any top-level folders were turned into notebooks. Notebooks are a new feature that allows you to keep sections separate. Read more about them on the first page of this Guide.
If you have additional folders (now called "section groups"), we recommend that you consider creating new notebooks and drag sections out of these folders into the notebooks. This note structure makes navigation between notes more convenient.

Tip: Expand the notebook Navigation Bar while you are reorganizing your note structure.


New features in OneNote 2007

	· Multiple notebooks
· Multiple computer support
· Shared notebooks
· Notebook synchronization and merging
· Outlook integration
· Outlook task synchronization
· Notes linked to Outlook items
· Send Outlook e-mails to OneNote
· Send Web pages to OneNote
· Hyperlinks between notes
· Insert files as printouts
· Notebook templates
	· File attachments on pages
· Recognition of text in pictures
· Tables
· Drawing tools
· Lasso Select
· Calculator
· Faster search
· Audio search
· Full page view
· OneNote Mobile for mobile devices
· Programmability import/export APIs


To find out how to use these features, flip through the page tabs in this section and the “More Cool Features” section in this Guide notebook.
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12. More resources

 

Visit the OneNote Site on Microsoft Office Online

Our site is continuously updated with new articles and Help topics based on feedback from customers like you. If you tell us a help topic needs improvement, we try to fix it so that everyone gets a better experience. On Office Online, you can find a variety of OneNote resources to help you:

· More in-depth Getting Started information
· How-to articles and videos, training courses, and quizzes
· Downloadable notebook, section, and page templates for all your activities
· Discussion groups where expert users can answer your OneNote questions
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Click here to visit the OneNote site on Office Online
 

 

Also check out the section "More Cool Features” in this Guide notebook (just click the section tab to open it). There you will find more ways to get the most out of your note taking.
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Inserted from: <file://C:\Users\dell\Documents\virsa.pdf>
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. "VIRSA" . (Heritage)
INTRODUCTION :

This contemporary drama will portray a small, affiuent, working
class, Kenyan/Asian family, long living in Nairobi. The aim is to
. show how all the family members are torn between traditional
(religious and cultural) values arid the pressures, temptations and
-~ ‘onslaught of moden life with all its exposures to foreign fashions
- and trends e.g. discos, drugs and alcohol etc.

STORY-LINE

Chand's father died when he was still a child. His mother
(Bibi-ji) struggled to bring him up and educate him to become a
successful, highly paid engineer.
* From his first marriage, to " Euvepean wowman, Chand had
- _ason, Neil (20 years old) and a daughter, Tanya (18 years old).
His first wife died on the birth of Tanya. Neil was emotionally
o T Ui affected especially when Chand re-married Shabbo __who
Mo e " ~ proved to be a self-centred, non-caring type of step-mother. Her
attention was mostly towards Chand's and her own son Vicky (15
years old) whom she pampers and spoils thoroughly. She often
has conflicting arguments with her husband, mother-in-law and has
a 'don't -care- a- damn' type of attitude towards the step-children.
Vicky and Tanya are prepared to listen to their grandma's ideas
~ and advice about gdod morals, honesty , a virtuous life and
keeping away from temptations (Heritage) but they do have their
own defences for their actions and can freely argue with her.

Neil, a final year University student, being the most sensitive
gets depression because of his own mother's death, the step-
mather's neglectful attitude and the very frequent squabbles in the
household. He starts on alcohal, smoking and drugs through peer
pressure from his rich class féllow Kiran, as an escapism from the
problems in his life. He has been lucky to find a decent girl Niki
(also in the university) who thinks highly of Neil and has the
impression that he is a straight-forward, “clean” person who loves
her and has got engaged to him.

To her horror, one day she discovers that Neil is on drugs and
she breaks the engagement. At the same time Neil finds out that
he has failed his final University examinations. In desperation, he
takes an over-dose of drugs and tries to commit suicide.

Did he survive or die - let it be ambiguous!




[image: image80.jpg]~ (I) Kiran's room, with a dim-lighted, smoky atmosphere. This can
be in front of the Ist curtain on the stage with a single bed, table,
stool, chairs and big posters on the walls. Eerie, 'mod' music in the
- back-ground.

(i) Chand's living room, a tastefully furnished spdce in a house in
an affluent suburb of Nairobi. This can be set in the beginning
behind the first curtain. There should be trendy fumniture, carpets,

' lanips etc.)

Tiﬂe episode takes place between 40.00 a.m. to 12.00 noon on
a Saturday moming in 1997. 2

CHARACTERS

1._Grandmother (Bibi-ji)
She is in her sixties. A pious, wise widow who struggled to
educate her son, Chand: She has high moral values and is very
uncomfortable with the modern trends in the present generation.
Her dress is a modest ‘salwar-kameeZ with a dupatta’on her head.
! She has a pendent around her neck and a'tasbi’'on her wrist. Her
way of talking is gentle but firm. She has conflicting views with her
daughter-in-law but has quite & good rapport with the grand-
children.

2. Chand :
He is a mature man in his late forties. He is a respectable
engineer in the private service. He is a down-to-earth, hard-
working and honest person. He has a good sense of hymour but
can be haughty and stern when provoked. Heis satisfied with his
‘way of life. With his first wife, 2 European woman, he had a son,
Neil and g daughter, Tanya on whose birth the mother died. With
the second wife ,Shabbo (Asian), he has a son Vicky. Inthe
beginning he is wearing a jogging suit and sneakers. Later he
appears in a two-piece western suit. When reading he uses
spectacles.




[image: image81.jpg]3. Shabbo : :
-She'is Chand's second wife. She is in her early forties. A smart,

“ beautiful, modern woman of rich back-ground. She is educated
and wants more in terms of luxury and comfort in life. She has a
streak of superficiality but has kept up some of her cultural values.
Towards the step-children she has a bossy, bullying and
_generally neglectful attitude while she pampers and spoils her own
son, Vicky.
Her dress is a fashionable sharara-kameez with / without the
dupatta on her
shoulder. -

4. Vicky ’ :
He is Chand and Shabbo's son. He is youngerto Tanya. Heis a
15 years old, modernised, care-free type of lad who loves 'rap' and
‘rock-n-toll'. He is repeating his 'O’ levels and hopes to pass this
time. He is pampered by his mother, expects support from her and
generally gets away with anything that he does. {
His clothes are 'hype'. He is wearing a tasselled shirt, flared
jeans, platform shoes, madern hair-do, ear-ring and a ‘walk-man'.

5. Tanya

She is Vicky's step- sister and Neil's real sister. A pretty teenager
in high school. She has the ' mod ' airs and an accent. She is
figure and beauty-conscious, very talkative, bold, too frank and
usually has the last word. In front of her step-mother she appears
intimidated and suppressed. With the grand-mother she has a
slightly retaliating attitude.

Her dress is a modern culottes and top. She has high-lighted her
hair, has coloured lenses in her eyes and wears 'junky' jewellery.

6. Neil

A final year university student. He is in his early twenties. Since
his mother died, he has felt neglected as the step-mother has
shown no motherly care for him.  He has gone astray due to
wrong company, is on drugs but has a nice girl, Niki, as his
fiancee. He has a disturbed personality, has a disillusioned
attitude and suicidal tendencies.

He is dressed in casual jeans and shirt.




[image: image82.jpg]7. Niki

A smart, well-dressed, pleasant-looking, decent and self-confident young
girl in her Ist year of university. She has a strong character and knows what
she wants. She is Neil's fiancee. Her dress is a casual top and jeans.

8. Kiran

He is Neil's class-mate, a rich and spoilt lad. He is a typical "sugar" (heroin)
junky. A thin, tall, lanky, care-free person who has managed by peer-
pressure to influence and lure Neil into drugs through the pretext of studying
together in his room. He is a fun-loving type of person

He is casually dressed in jeans and vest.

9. Narrator (OpHewal®)

A powerful, authoritative voice only, preferably male. He must have clear
diction and fluency in his speech. He has to introduce , depict the theme and
conclude the drama. This could be a pre-recorded voice or 'live'




[image: image83.jpg]SCENES
FLOW/ SEQUENCE

1. Narrator - a male powerful voice only to give the general gist of
the drama. ( ©ptiowet

.2, In Kiran's room. Scene to depict Neil's character. Neglect of
parents leading to present situation i.e. taking drugs etc.
Confrontation with Niki in the presence of Kiran.

3. Shabbo and Tanya in argument in their fiving room over a
parents meeting taking place i Tanya's school today morning.

4. Enter Chand after ajog. Has a short conversation with Tanya.
Argurnent with Shabbo. The phone call. Exit of Tanya.

5.Entry of Grandma. Discuss Neil, conflict with daughter-in-law
who threatens to leave the house. Chand tries to pacify the
situation. Exit of grandma.

6. Enter Vicky, discuss Neil, tiff with Father. Mother siding the
son. Chand scolds Shabbo.

7. Father leaves the room to get ready for his meeting. Mother
pampers Vicky and gives him some money. Exit of mother.

8. Vicky, in his own world of dreams, imagines that he is dancing
with his friends (some girls and boys) with some modern music .
Appropriate lighting and other effects. A disco dance number.

9. Tahya enters. Step-brother and sister teasing each other and
finally shouting at the top of their voices. Some comments on
Neil's odd behaviour these days.

10. Enter Grandmother. She gives advice and is reminiscing.

11. Enter stressed Neil into the living room. He is looking weak
with over-dose of drugs taken because of his failure in the
examination and Niki‘s dumping him.

12. Panic as Neil faints and is taken to hospital. Everybody's
reactions, feelings and emotions to be shown as Neil is in a critical
condition and can die,

13. Grandmother's advice to youngsters and parents.
14. Conclusion A % = :

. " it =
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Narrator,

- (Voice only while glimpses and silhouettes of the characters are
shown in subtle actions on the screen.)

- He gives an introduction to the background of the family involved in

the drama, arousing the curiosity of the audience and retaining the

suspense of the happenings that will take place this Saturday

,morning.) S+“‘3 Lt s, 553 Pa i , 2 Sea Py d

Sequence 2. (“DRUG SCENE")

(In Kiran's room with simple, scanty furniture and generally
neglected and untidy. Low eerie music in the back-ground. Lights
are dim. Neil is sitting on the bed with a cigarette and an

- alcohoalic drink in a glass. Some syringes, drug powder etc. on a
stool. Kiran is also there, sitting on a chair, puffing away oblivious
of anything else. They are in the act of injecting themselves on
their arms when Niki suddenly walks in through the door.)

NEIL: Oh, that's great! Kiran, | feel good already!

KIRAN: (laughs in high spirits) Neil, didn't | tell you so? It makes
me forget all my worries.

NEIL; You can say that again Kiran. Look what I've been through.
Since my mother died, | have felt so alone. Dad never had enough
time for me. My step-mother has never shown any motherly
affection towards me.....

KIRAN: Come-on Neil, forget these sob stories. That's why |
- always invite you over to drown your misery in this (points to glass
of alcohol)

NEIL: Last night, Kiran, | had to stay here with you. | couldn't
have faced my Dad after knowing how badly | have flunked my final
university exams.. What am | going to do, Kiran?

KIRAN: Ahh.... Don't give a damn Neil.... here take a puffl
You can always repeat the year, can't you?




[image: image85.jpg]NEIL: (taking a puff) Kiran you don't understand! What will I do when Niki,
my fiancee finds out about all this (points to the alcohol and the drugs) She
is one person who has shown some concern for me. Yes! She loves me.
Since our engagement she's literally worshipped me. She thinks | am her
ideal. If ever she found out the truth... I'm sure she will want nothing to do
with me again ...and... i oh.... I'd kill myself!

KIRAN: Don't be funny, yaar. Stop this non-sense and self pity. Can't you
forget Niki for now...... Forgetitall ..... Just enjoy the present life!!

( A knock at the door)
KIRAN: Who could that be? (slurred speech) T Bt
NEIL: Who cares! Here give me that drink again. 7 e N

(Kiran gives him the glass)
(Louder knaocking at the door) \ |
KIRAN: Okay, Okay, I'll get it. (Gets up, almost falls and staggers to tNe
door. He opens the door)

KIRAN: ....and who are you? (sleazy look) 5

%

(Niki looks at Kiran, is shocked, shoves him aside and moves towards-Neil.
She is stunned and very angry indeed.)

Niki: Kiran!

Kiran: Niki!

NIKI: (shocked and angry) Neil, you've been drinking again? Oh my God,
Neil! Do you realise I've been looking for you the whole of yesterday. Your
results were out and | wanted to see you badly. | guessed you would be
holed up here!

(Looks at the alcohol, syringes etc. and is flabbergasted)

NIKI: What are you up to Neil? You.... you.. on drugs!

KIRAN: Sh....Sh... don't make a fuss! We are enjoying ourselves!
(Walks back to his original place on the chair)

NIKI: Neil, stop it for God's sake!

(Turns to Kiran)

So, this is what you two have been doing all this time! You were always
pretending to everybody that you two study together here! Your secret is out
now!

NIKI: (To Neil) Please Neil, Stop this now! Don't you know you are ruining
yourself? Problems never get solved with drugs! (Tries to snatch the syringe
from his hand but in vain)
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NEIL: (already a bit high....laughs) Oh Niki, my dear, stop lecturing! This is,,,//

the real life... come...come....try it yourself! // Y
/ #

NIKI: (trying her best to be patient) Neil, don't you know that | love you. | g

care for you. We are engaged, we were supposed to marry soon. What's

come over you? | thought you were my friend. I loved you with all my }

heart! This is the most dreadful disillusion of my life..... [thogght you had N

such high morals and exemplary virtues. i

NEIL: Virtues! High morals!
(laughs hysterically and kicks a stool nearby, making everything fall on the

floor)

Cut it out! Don't give me any more crap woman! It's all hypocrisy! You
know very well how my parents have neglected me for their own personal
businesses and misunderstandings. And yes, I've flunked those damned
exams, so what? What's there left for me in  this cruel world ... and ....
anyway THIS... THIS.... (points to the drug powder etc.) is my solace, my
own world....

NIKI: (very emotional with tears in her eyes) Very well Neil! Stay in your
world alone. | will not be part of it.  Good-bye, good-bye for ever and here
is your damned ring! You cheat, double-faced punk! You junky - | hate you,
| hate you!

(She holds him from the shoulders and shakes him thoroughly, then removes
the ring from her finger and throws it at his face. Neil holds her wrist and
twists her arm to hurt her. After a bit of a tussle, Niki manages to free herself
and storms out of the room. On the way out she smashes a vase onto the
floor, breaking it.)

Niki: It's all over ..... Go to hell!!

NEIL: (Laughs hysterically and starts giving himself another shot) Yeah,
Yeah! (sarcastic tone) Go, go ahead dump me ..... even you can abandon
me.... Nobody has really cared for me anyway!!

Niki leaves the room banging the door behind her.

KIRAN: Yeah, let her go yaar! Women! Who needs them! Here take
another shot!

(Both Neil and Kiran begin drinking profusely and start injecting themselves
with some drugs, finally staggering onto the floor.Stage darkened, end of this
scene)
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(A Tiving room with trendy furniture, carpets, lamps, wall hangings, clock, a

music system telephone, dining / coffee table etc.

Shabbo almost ready to go out, is manicuring her nails . She is humming an
original song and trying to relax, blowing at her nail varnish and enjoying
herself.

Tanya comes in with a letter from her school.)

TANYA: (Holds the mother's shoulder but Shabbo shrugs her off) Mum, Hi!
You are looking 'fab' as usual. Are you getting ready for the Parent's Meeting
at my school today morning? | came to remind you that Dad and you must
be there at 11.

SHABBO: (curtly) Listen Tanya, | am getting ready for my Kitty party today. |
have to go to Linda's place at 11. Sorry child! | cannot make it to your

school.

TANYA: But Mum, everybody's parents come to discuss their children's
progress with the teachers. You people never come for any of my school
functions!

SHABBO: Oh stop whining all the time. I've already told you | cannot make it
to your school today. Why don't you ask your Dad to go? | wanted to talk to
him last night but he came in so late from some meeting and now he's
already out jogging!

Anyway, | had asked you to bake a cake for tea, have you done it?

Sequence 4

(Chand enters, in a jogging suit, ruffled hair and towel in hand. Panting a
little, stretches and starts looking for his spectacles and the newspaper)

TANYA: Yes, Mum, I've already put it in the oven. But, my parents' meeting,

Chand: (td Tanya) How is my Tanya today?

Tanya: Fine, Dad. How was your jog?

Chand: Oh, it was long and tiring, as usual!

Tanya: (in a haughty tone) Dad, It's my parents' meeting today. | always get

embarrassed when the teachers ask me why my parents never come for any
of my school occasions.
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CHAND: Shabbo, honey , why don't you attend Tanya's school function?

(Tanya starts making tea for the parents

SHABBO : Oh I've to go for my kitty party at 11.

(checking watch) | mustn't be late.

CHAND : (looking at newspaper) Since when this punctuality . From your life
style, | would have thought there is no hurry in Africa - and - kitty party!
You women! | don't understand what you do at these Kitty parties - sit and
gossip over pastries and samosas , and shred some poor husband to pieces!
... tch .. tch - utter waste of time ...

SHABBO: (laughing and looking into a mirror)
Come on Chand , as if you men don't ever waste time - like when you are
glued to the T.V watching that wrestling - | should call it bone breaking !

CHAND: (gets up and goes to the music system)
Oh that is exercising - our eyes ! .... and do you know sports is the micro-
cosm of life !

(to Tanya) Tanya, don't just stand there! Pour the tea for you Dad!
Tanya: Yes Mum.

Shabbo: (to Chand)
And that reminds me - How come you came home so late, last night? Were
you and your 'friends' enjoying at the 'Mujra' again?

CHAND: (angry, gets up as if to slap her but controls himself in time)

How dare you say such a thing infront of Tanya! | told you | had a meeting at
the office - there is a very important project going on. | don't know why you
have such a suspicious mind. Why can't you concentrate on your home and
forget your silly 'kitty' parties!

SHABBO:" Well, aren't you forgetting that you were the one who stopped me
going to work in the first place! What should 1 do in the house the whole day
? It gets so boring. | have to get out of the house. That's why | keep myself
busy with my 'silly’ kitty parties.

CHAND: Why can't you do something more constructive ?
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SHABBO : My job was constructive , Chand, but you ruined my career.
(mimicking him)

"l don't need your money " you said . You never wanted me to keep my
individuality. You always wanted me to live in your shadow. Now you want me
to stop having the little social life that | have .(fuming)

CHAND: Social life! Shabbo you should be giving more quality time to the
children. They need you. | keep telling you this but it falls on deaf ears...

Tanya: (Disgusted) There you go again! | can't stand these arguments all the
time! I'll go check on my cake.
(Tanya exits)

SHABBO: They are old enough now. | cannot baby-sit YOUR children all the
time.

CHAND: (head on his hands) You kriow Shabbo, you intentionally ignore
both Neil and Tanya. When Neil's mother died he was very young and your
neglect has turned Neil to an alien to this house.

SHABBO: Now don't you start talking to me about that woman. You can't
get her off your mind, can you?

CHAND: Oh, come on, Shabbo! You don't have to feel this way. You know,
I love you. | am just worried about Neil's frequent absence from the house.
He's hardly ever around. Even last night, he didn't come home. | just
wonder what he is up to!

SHABBO: (laughing scornfully) Poor Papa, missing his 20 year old baby, is
he? Well, since he got engaged to sweet Niki, he doesn't have time for you
He must be with her most of the time!

CHAND: (to Shabbo)
...... and my Tanya.... she is always looking up to you for motherly affection.
Do you give her any attention? I'm sure, you wouldn't treat her like this if she
were your own daughter.

SHABBO: (Angry tone)

Go on! Blame me.... blame me for everything that goes wrong in the house!
What about yourself? Chand, how much time do you give to your kids?
You are always on site or attending some meetings. The children are also
your responsibility! Don't pass the buck onto me all the time! And that
reminds me....you go for your Tanya's parents' meeting today!
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( The phone rings . Chand waits for Shabbo to pick it, but she ignores it.
Chand has to get up and take the phone)

CHAND: Hello?

Yes , Chand here (pause)

Yes, David, what is it (pause)

What , today on a Saturday ? (irritated) OK . OK . I'll be there .

( He puts the phone down and turns to Shabbo.)

CHAND: Shabbo ! It's going to be impossible for me to go to Tanya's school.
| have to be on site by 12. There is another urgent engineers' meeting. It
had to come up today ! Shabbo, just get my clothes organised.

SHABBO: ( Still angry . Keeps sitting )

You can get your things yourselfl The maid is not around today. You know,
she's gone for her mother’s funeral . | don't think she'll be back till next week .
Oh, 1don't know how I'm going to manage. That's why I'm always telling you
- we need two house-maids .

CHAND: ( has poured himself another cup of tea and is sitting at the dining-

table)
There you start again - always complaining , for ever wanting more, tell me!
What don't you have - lovely kids , a new car, a spacious house - what

¥ more do you want?

SHABBO:( Starts counting on her fingers) Well another maid for
starters , our own swimming pool ,..my personal Jacuzzi....

Sequence 5

Enter Grandma. Stands quietly and listens to the argument going on. She
has a horrified look on her face!

CHAND: Greed, greed ... and false prestige - that's what I call it. You have
no limits to your wants and desires . Just think of those unlucky ones, who
don't even get one square meal a day - forget about a roof above their
heads . | bet the cost of one swimming-pool could feed a thousand hungry
mouths for a whole year! (Gets up and walks to his brief-case)

SHABBO: Hhmmph! Oh you and your philosophy of compassion . ( With
exasperation , starts arranging some flowers in a vase)
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is this household ever going to have a peaceful day? | pray day and night for
your welfare but God help you! Chand...

Chand: Yes Ma.

Grandma: Chand‘betay,’ did you see or talk to Neil at all last night? I'm
worried about him. He seems to keep away from the house too often.
Shabbo, did you see him?

Shabbo: | keep busy. | don't know anything about him.

Grandma: hun... busy!.... and would it be asking you too much to avoid these
ealy morning arguments? When are you going to start setting good
examples to your growing teen-aged children?

SHABBO: Oh, spare me from you usual "holier-than-thou" attitude. Please!
Stop interfering.

GRANDMA: Yes, you can say | am always interfering but how can | ignore
the happenings under one roof? You two are always busy or at daggers with
each other, even in front of the children. The mother-less Neil and Tanya are
always being ignored and neglected and you Shabbo... are always
pampering your own Vicky. It's not fair, Shabbo! If you really loved Chand
you would treat all the children equally!

SHABBO: (to Chand) Chand! Tell her to stop provoking me. Her sermons
make me sick. She always preaches that 'bahus' are like your own
daughters, but, does she treat me like her own? She's always finding faults
and criticising me all the time! Sometimes, 1 wish | could just go away some-
where else. Chand, if | decide to leave this house, it will be all because of
this woman! (almost crying)

GRANDMA: (to Chand) (very emotional) Hun, hun, Tantrums!

See.... see .... betay, how she talks to me! As your mother don't | have any
right to point out wrong doings going on in this household? | would never
want this household to break apart. | just wish you would all live together
more harmoniously.

CHAND: Ma, Ma, please calm down. | have so many other things on my
mind. Take it easy. Everything will work out , | hope! Shabbo, you don't
have to answer back so rudely. She says things for our good, you know!

SHABBO: Yeah, yeah, take her side, as usual - She's always right and I'm
always wrong. How these mothers monipulate their sons!

GRANDMA: Toba, toba. God help us!!

(Brandma adjusts her dupatta on her head and walks out, muttering under
her breath)
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Sequence 6

(Enter Vicky with ear phones and a walk-man, shaking with the
rhythm of the music, walks past parents without acknowledging their
presence. He stops near the music system.)

CHAND: (removing glasses , he snaps his fingers in front of Vicky) Morning
Vicky! Isn't everybody up early today?

Shabbo gestures to Vicky to make the music low. Vicky comes to the Father
and Mother. He has removed his ear-phones.

Vicky: Hi Dad, Hi Mum!
Chand: Any plans up your sleeve?

VICKY: Hey, I'm so excited today I'm going to this new club. | am attending
aparty at the 'Moto-Moto' club to-night.

CHAND: Vicky, you are always going for parties on your own. Why don't you
include Neil in your activities? You know it well enough that he prefers
staying aloof but | think you should try to be a friend to him rather then just a
younger brother.

SHABBO: Oh, my Vicky is so self confident; he makes friends so easily. It's
Neil who always seems confused. Sometimes | feel he acts quite impuisive
and fickle. He is so secretive, too. In my opinion he has a disturbed
personality!

VICKY: Come on Mom! Neil's really cool. He's been really slogging hard for
his finals with his friend Kiran. His exam. results were supposed to be out
yesterday. But he never came home last night, so | wonder how he fared.
(changing the subject)

Anyway, Dad, can | have some cash for to-night?

CHAND: What? Again? This is the second time this week. Where do you
spend all this money, by the way?

(Vicky ignores the question)
CHAND: (Takes wallet out of his pocket)
Any way, how much do you want today?

VICKY: (avoiding Father's eyes) Just five thousand.

CHAND: What! Five thousand! That's too much!
(Puts wallet back without giving him anything.)



[image: image93.jpg]15

VICKY: But Dad. | need it. All the other guys are gonna be

there in the evening and they always have enough money to burn. |
don't want to look miserly in front of them. | want to have real fun!

1 want to look cool!

CHAND: (glaring) | don't think highly of your "other” guys. They
always look and behave as if they are high. I'm sure they are into
drugs. What do they call them these days - Smarties. Disco Biscuits!!

SHABBO: There you go again! Whenever he wants to go out

with his friends you start harping about drugs and alcohol.

(walks to Vicky and pats him) My Vicky is not like that. Have you ever
enquired from Neil where he spends most of his time and your money?
Come on, Chand, let Vicky, too, have a good time. You are young only
once, give him the money!

CHAND : Shabbo, Shabbo. It is not a question of money - it's the

principle that matters. He is provided with everything in this house - what
does he need extra cash for? Don't you know, the more

money youngsters have the more venues they discover to squander it. And
isn't he supposed to be concentrating on his studies to pass this time? 1 still
haven't compromised with his repeating his 'O' levels!!

VICKY: Oh chill out Dad, calm down. It's no big deal. |'m sure to sail
through this time. You'll see.... (walking with cereal bowl towards side bar)

CHAND: (disgusted, walking out of the room. He has taken his jacket and
towel and put it around his neck. Reaches near the door)

| am always making you children aware of your responsibilities and priorities.
The rest is up to you It is a question of your own lives after all.

(to Shabbo)

| have to get ready for my meeting. Shabbo, you can deal with him!

( Chand leaves the room .)
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SHABBO: (to son) Take it easy Vicky. Your Dad means no harm. | would
hate to see you go astray.
(puts her arms around her son)

VICKY : (angry) Yeah, yeah. | know that but, Mom, | don't like

him breathing down my neck
(speaking under his breath -mumbling)
He's such a grouch sometimes! God!!

SHABBO: Buus, buus! You don't have to be rude. Here's some money
(removes it from her purse).

Make do with it!

(going out)

Oh, 1 still have to do my hair - (Shabbo rushes out of the room. Vicky puts

the money in his pocket but is not so happy)

Sequence 8

(Vicky sighs deeply. Then he walks to the music system, changes the C.D
and starts dancing with the loud music, oblivious of anything else.

Disco effects, coloured lights etc.)

VICKY: Oh, this music takes me to another world.

(He goes into a trance )
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(Tanya walks in carrying a cake in a plate. She puts it down on the coffee
table, mimics Vicky a bit and then switches off the music to bring him down to
earth and get his attention. The imaginary boys and girls have disappeared.
The atmosphere is the same as before.)

TANYA: (cheekily)
Vicky, Vicky! Can't we have some peace and quiet here!

VICKY: And what's bugging you, Tanny baby?

TANYA: Oh, don't call me a 'baby' . | hate it! The grown-ups in this house
are always behaving more childishly and immature than us kids!

VICKY: Ah, take it easy, sis. Life is too short to bother about petty
squabbles and arguments. Hey, did Neil come home last night?

Tanya: | don't think so!
Vicky : | worry about Neil. | wonder what he is up to!

TANYA: Yeah, | don't believe that Kiran and he spend all that time studying
together. | bet they are up to no good!

(changes the subject)

Anyway, here try some cake. | made it!

(cuts a slice and offers it to him. Licks off some cream herself, too)

VICKY : A fine way to finish me off, eh?

TANYA: Of course not, silly. If | wanted to do that, | would just push you over
your stupid boots!

VICKY: Then why are you always trying your new recipes on me? Have it
yourself! Put on some more fat, as if you don't have
enough already.

TANYA: What! Fat! ME! (walks around him)
Look at yourself - look at your hair - as if a lawn-mower has gone hay-wire!
Look at your ear-ring -- getting familiar with your feminine side eh?

(Really angry - throws the newspaper (or cake) at him.

VICKY: Oh stop it and shut up you fatty, fatty bumbola!
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TANYA: Shut up yourself, you brute.... wait till | tell Dad about
those 'porno’ magazines hidden under your mattress and ..those

cigarettes.....

VICKY: You, you devil...tell-tale... you've been going through my things
again! I've told you to keep away from my room and

mind your own business !! Fat Witch!!!

(moving as if to strangle her)

Sequence 10

(Grandmother walks in, disgusted at the din. She is in salwar-kameez and
the dupatta is on her head)

GRANDMA:' Toba, Toba'! What on earth is happening here?

Vicky betay, stop teasing her. I've told you so many times before not to call
her

fatty. She is my delight, my beauty, call her by her lovely name

Tanya - | named her myself

(Tanya has run behind the grandma and makes faces at Vicky)

TANYA: You see Dado, he's always teasing me. He thinks he is a super
man and he can get away with anything. Even Mom favours him all the time
He always gets his own way. Do you know he is going to that 'Moto-Moto'
Club again. Dado, even | want to go too, please, please, Dado!

GRANDMA: Oh ho. Slow down Tanya! "Moto-moto”! Toba, toba my child
What kind of evil name is that? That's not a place for a decent girl to go to.

TANYA: Why? If Vicky can go anywhere he wants to, why
can't1? s it because he is a boy? Even | want to be 'in’, not old
fashioned and narrow-minded!

GRANDMA: Now Tanya, don't get too over-clever! You know

very well that we all love you both. It's just that Vicky can look

after himself and you - we don't want you to get into any sort of trouble - we'd
be doomed ... if something happened to our baby... We restrict you only
because we CARE..
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TANYA: Oh, | feel suffocated here. I'm tired of being nagged - don't do this,
don't wear that, don't go out with him, don't bring her home.... | wish you
people would trust me a bit more and care a bit less!

(Vicky mimics her)

GRANDMA: Less? Did you say less? We should care less? What are you
saying child? Do you know what happens to those boys and girls who are
not cared for? Tanya, you read magazines and newspapers - you sh_ould
know more than me about child molestation, rape, teenage pregnancies,
drug abuse, drunkenness and this new dreadful disease that | keep hearing
about these days what is it called ... A1.D.S.!

TANYA: Dado, | know about all this - but.... | can look after myself. | am
strong and confident!

GRANDMA: Come, | want to share something with you.

ey —

GRANDMA: | could have gone astray but | always kept in mind
. what your grandfather used to say, "Bibi, stick to high morals,
_respect family values, never be afraid of hard work, do what is right
. and always trust in God." | want you also to remember this and
~ appreciate the values of a virtuous life!
My children, this is our true "Heritage" and | do not want you to
. ever forget that!

i (The children are sitting around their Grandma while she is
reminiscing . Vicky could be drinking some juice etc. Grandma
starts brushing and plaiting Tanya's hair which was open before.)

GRANDMA: (continues) Through my stitching, | managed to make
ends meet with dignity. Even your father, Chand could have fallen
prey to peer pressure and ruined himself but with the grace of God,
he did not falter and he is blessed today. Everybody respects him

for his honesty and hard work.
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VICKY: (Having some juice) But Gran... when you guys were
young - those were ancient times - those traditions and ways are
irrelevant now - you never had what we have now - the media, T.V.
foreign movies, computers, inter-net - name it - we are exposed to
all foreign values - and you guys are the ones who have
introduced all this into our lives. The 21st century is around the
corner, you can't lock us up behind cages now!

GRANDMA: Toba, toba! Who said anything about locking up?

" Limits = my children - limits. You have all the freedom to pursue

*any career, any job - but character degradation,. we will not
tolerate! | know today, life for the youth is harder than ever before.
You are exposed to so much more temptation. But, why do yoy
want to ape the negative aspects of foreign cultures? Ask yourself
- where are you people going? What is the purpose of your life?
Wiill this moral decadence ever end??

(Urgent knocking at the door.)
TANYA: Oh, I'm sick and tired of all this! Let me go and see who

it is! ]
(Tanya goes to get it.)

' Sequence 11.

VICKY: Who can that be? (Nibbling at some snacks)

- (Neil comes in looking weak and depressed, holding a result slip in
his hand)

i
. TANYA: (screaming) What! Oh my God! (expression of shock
~and horror)

VICKY: . Oh Neil, waz-up? We missed you last night, bro. What
happened about your results yesterday?
(Neil staggers to the couch near the grandma)

GRANDMA: Yes Neil betay, what's wrong? Are you feeling all
right?
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. NEIL: It's over...Everything....,.Everything is finished.... | am fed up
of this life!  (Hysterical, a bit unbalanced , appropriate actions and
expressions.

 TANYA: What's happéﬁed Neil. You look;sick brother. Were the
~ results that bad?
(Holds his hand )

- NEIL: (Pushes Tanya away) S
Itis the end for me. My results....... (trying to stand up)

VICKY: ......50....what about thow |

NEIL: | flunked.... the whole year's slogging has gone down the
drain. | am a good for nothing  ...... R 8

(gives Vicky the result slip and feeling dizzy)

..... Nobody can help me......s Nobody loves me.

(Vicky reads the result slip and comes close to Neil to console
him)

(' Some symptoms- heart fluttering, jaw-clenching and teeth
L grinding)

TANYA: ) B
B e R . Niki, your fiancee!
What about her, where is she?

What's happened?

NEIL: She ...she broke off the engagement with me.
(Hysterical) Here, Vicky - you can give her back this ring.

VICKY: Now, calm dowri, big brother! We can talk this over. I'm
_.sure Niki will come round. It's just a misunderstanding.

NEIL: No, np. She foundout ......... 1 know | could not have
. hidden this fact from her for ever.

GRANDMA: "...Found out what, betay? .
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NEIL: .... that | am on drugs AForgive me Grandma, | have fooled

you and évery-body else. It just started as a prank in school 6‘“’“ et
_together with Kiran. One thing led to another and | became
" addicted - | became so dependent that | couldn't live without it.

(Grandma and others are horrified)

~ VICKY: But, howdid Niki find out about it?

A NEIL: Today morning, she caught me in Kiran's room while we
- were both giving ourselves the shots. Then hell broke

(extremely emotional and hysterical)

i She threw the ring at my face, called me all sorts of names and left,
banging the door on my face...... she doesn't want to see me again.
She told me to go to hell and | am..... | am..

GRANDMA: . Oh God |

(Neil faints) What have you done to yourself? Speak up my
child......speak up!

(Shakes him. Tanya brings a glass of water. Vicky holds Neil's

hand.)
NEIL: I.......1.......I've taken an overdose of...... I'm going to die.....
Let me die. ..Nobody cares anyway.....

(Faints. Symptoms like sweating, clenching etc.)

Sequence 12

TANYA: Don't say that Neil. We all love you. We need you, my
brother. Don't leave us!

(very emotional, starts crying and shouts)

Mum, Dad! Hurry up! Come here quick! Neil's here!

(Chand and Shabbo hurry in. Chand is in a suit now.)
CHAND: What's going on in here? Neil, my son, what have you
done to yourself?

(Sees Neil lying on the sofa. Feels his pulse and shakes his head)

VICKY: (Panic) He's taken an over-dose!
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Niki's ditched him! He's also flunked his exams.

GRANDMA: O my God! This curse was bound to fall on this
_trouble-ridden household.

(starts wiping tears from her eyes)

-0 God help my child, my poor, sensitive lad!

Shabbo: What is it Chand? Are you sure he is not pretending?

Chand: Stop it woman! His pulse is hardly there and you are saying he is
pretending.

Shabbo: How should | know! Hun.... hardly any pulse!  What!

Chand: Stop panicking. His condition is critical. We must get him to the

coma or even die! We couls lose our Neil for ever!!

Vicky: Neil, don't leave us my brother.... don't do this to us ...Neil....don't

(They all gather around unconscious Neil on the verge of carrying
him.out. The scene freezes here. The siren of ambulance can be
- heard in the distarice. Tragic (death) music in the background.

- Only the Grandmother comes t6 the front of the room . Ina
- pensive mood  and very sad indeed.)

The grandmother's tearful and very emotional voice echoes:

il is just one of the many victims of froubled house-holds and
the tribulations and frustrations of modern living. We as parents
and as a society have a duty- to set good examples, give the right
guidance and to channel the growing minds of the youth towards
making the right decisions in spite of the temptations which in
many forms have been and will always be there."

hospital as soon as possible. There is no time to waste! He could drift into a
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. the Grandmother continues

*

""" Be not engrossed in things ephémeral,
To the neglect of higher things in life.

Life is but short and death will soon claim you.

Oh that men would only learn,

before it is too late, X

the serious issues of the higher life!

They must taste the consequences of their neglect.
For every good enjoyed, they must

In the hereafter give a strict account..' "

-THE ENP-

* Sura Takathur (Piling up) from The Holy Quran.
Translation commentary -Abdullah Yusuf Ali ¢.282.Pg.1777..cii 1-8

Copy right. Shama Butt (B.Sc.)

Computer Graphics and
P.O.Box 41642,  Manuscript Typing by
NAIROBI, Najia & Mustafa Butt.

Kenya. March 1997.
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“VIRSA” (Heritage) ,Z 
INTRODUCTION 

This contemporary drama will portray a small, affluent, working class, Kenyanfsian family, long living in Nairobi. The aim is to 

•show how all the family members are torn between traditional (religious and cultural) values and the pressures, temptations and 

• onslaught of modem life with all its exposures to foreign fashions and trends e.g. discos, drugs and alcohol etc. 

STQRY-LINE 

Chand’s father died when he was still a child. His mother 

(Bibi-ji) struggled to brihg him up and educate him to become a 

successful, highly paid engineer. 

- From his first marriage, to Eu.vopea owi Chand had a son, Neil (20 years old) and a daughter, Tanya (18 years old). Jlis first wife died on the bjrth of Tanya. Neil was emotionally affected especially when Chand re-married Shabbo who proved to be a self-centred, non-caring type of step-mother. Her attention was mostly towards Chand’s and her own son Vicky (15 years old) whom she pampers and spoils thoroughly. She often has conflicting arguments with her husband, mother-in-law and has a ‘don’t -öare- a- damn’ type of attitude towards the step-children. 

Vicky and Tanya are prepared to listen tc their grandma’s ideas and advice about good morals, honesty, a virtuous life and keeping away from temptations (Heritage) but they do have their own defences for their actions and can freely argue with her. 

Neil, a final year University student, being the most sensitive gets depression because of his own mother’s death, the stepm others neglectful attitude and the very frequent squabbfes in the household. He starts on alcohQl, smoking and drugs through peer pressure from his rich class fellow Kiran, a an escapism from the problems in his life. He has been lucky to find a decent girl Niki (also in the university) who thinks highly of Neil and has the impression that he is a straight-forward, “clean” person who loves her and has got engaged to him. 

To her horror, one day she discovers that Neil is on drugs and she breaks the engagement. At the same time Neil finds out that he has failed his final University examinations. In desperation, he takes an over-dose of drugs and tries to commit suicide. Did he survive or die - let it be ambiguous! 
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THE LOCALE 

(I) Kiran’s room, with a dim-lighted, smoky atmosphere. This carl be in front of the 1st curtain on the stage with a single bed, table, stool, chairs and big posters on the walls. Eerie, ‘mod music in the back-ground. 

(ii) Chands living room, a tastefully furnished space in a house in an affluent suburb of Nairobi. This can be set in the beginning behind the first curtain. There should bB trendy furniture, carpets, larrips etc.) 

The episode takes place between 10.00 a.m. to 12.00 noon on 

a Saturday morning in 1997. 

CHAR4CTERS 

1. Grandmother (Bibi-ji) 

She is in her sixties. A pious, wise widow wtio struggled to educate her son, Chand. She ha high moral values and is very uncomfortable with the modem trends in the present generation. Her dress is a modest ‘ saiwar-kameel with a ‘dupatta’ on her head. 

4 She has a pendent around her neck and a’tasbi’on her wrist. Her way of talking is gentle but firm. She has conflicting views with her daughter-in-law but ha quite a good rapport with the grandc hildren. 

2.Chan 

He is a mature man in his late forties. He is a respectable engineer in the private service. He is a down-to-earth, hardr king and honest persQh. He has a good sense of humour but can be haughty and stem when provoked. He IS satisfied with his way of life. With his first wife, a European woman, he had a son, Neil nd a daughter, Tanya on whose birth the mother died. With the second wife Shabbo (Asian), he has a son Vicky. In the 

beginning he is wearing a jogging suit and sneakers. Later he appears in a two-piece western suit. When reading he uses spectacles. 
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3. Shabbo 
She is Chand’s second wife. She is in her early forties. A smart, 

beautiful, modern woman of rich back-ground. She is educated 

and wants more in terms of luxury and comfort in life. She has a 

streak of supecility but has kept up some of her cultural values. 

Towards the step-children she has a bossy, bullying and 

generally neglectful attitude while she pampers and spoils her own 

son, Vicky. 

• •• Her dress is a fashionable sharara-kameez with 1 without the 

dupatte on her 

shoulder. 

4. Vicky 
He is Chand and Shabbo’s son. He is younger to Tanya. He is a 15 years old, modernised, care-free type of lad who loves ‘rap’ and ‘rock-n-toll’. He is repeating his ‘0’ levels and hopes to pass this time, He is pampered by his mother, expects support from her and generally gets away with anything that he does. 

His clothes are ‘hype’. He is wearing a tasselled shirt, flared jeans, platform shoes, modem hair-do, ear-ring and a ‘walk-man’. 

5. Tanya 
• She is Vicky’s step- sister and Neil’s real sister. A pretty teenager in high school. She has the’ mod’ airs and an accent. She is figure and beauty-conscious, very talkative, bold, too frank and usually has the last word. In front of her step-mother she appears intimidated and suppressed. With the grand-mother she has a slightly retaliating attitude. 

Her dress is a modern culottes and top. She has high-lighted her hair, has coloured lenses in her eyes and wears ‘junky’ jewellery. 

6. fiI 

A final year university student. He is in his early twenties. Since his mother died, he has felt neglected as the step-mother has shown no motherly care for him. He has gone astray due to wrong company, is on drugs but has a nice girl, Niki, as his fiancee. He has a disturbed personality, has a disillusioned attitude and suicidal tendencies. 

He is dressed in casual jeans and shirt. 
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7. Niki 

A smart, wall-dressed, pleasant-looking, decent and self-confident young 

girl in her 1st year of university. She has a strong character and knows what 

she wants. She is Neil’s fiancee. Her dress is a casual top and jeans. 

8. Kiran 

He is Neil’s class-mate, a rich and spoilt lad. He is a typical “sugar” (heroin) junky. A thin, tall, lanky, care-free person who has managed by peer- pressure to influence and lure Neil into drugs through the pretext of studying together in his room. He is a fun-loving type of person. 

He is casually dressed in jeans and vest. 

9. Narrator COeJ 

A powerful, authoritative voice only, preferably male. He must have clear 

diction and fluency in his speech. He has to introduce , depict the theme and 

conclude the drama. This could be a pre-recorded voice or ‘live’ 
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£CENES 

FLOW/SEQUENCE 

1. t4arrator - a male powerful voice only to give the general gist of 

the drama. 

2. In Kjran’s room. Scene to depict NeWs character. Neglect of 
parents leading to present situation i.e. taking drugs etc. 

Confrontation with Niki in the presence of Kiran. 
3. Stiabbo and Tanya in argument in their living room over a parents meeting taking place in Tanya’s school today morning. 

4. Enter Chand after a jog. Has a short conversation with Tanya. Argument with Shabbo. The phone call. Exit of Tanya. 

5. Entry of Grandma. Discuss Neil, conflict with daughter-in-law who threatens to leave the house. Chand tries to pacify the situation. Exit of grandma. 

6. Enter Vicky, discuss Neil, tiff with Father. Mother siding the son. Chand scolds Shabbo. 

7. Father leaves the room to get ready for his meeting. Mother pampers Vicky and gives him some money. Exit of mother. 

4 

8. Vicky, in his own world of dreams, imagines that he is dancing with his friends (some girls and boys) with some modem music. Appropriate lighting and other effects. A disco dance number. 

9. Tanya enters. Step-brother and sister teasing each other and finally shouting at the top of their voices. Some comments on Neil’s odd behaviour these days. 

10. Enter Grandmother. She gives advice and is reminiscing. 

11. Enter stressed Neil into the living room. He is looking weak with over-dose of drugs taken because of his failure in the examination and Niki’s dumping him. 

12. Panic as Neil faints and is taken to hospital. Everybody’s reactions, feelings and emotions to be shown as Neil is in a critical condition and can die. 

13. Grandmothers advice to youngsters and parents. 

14. Conclusion . . 
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Narrator. 

(Voice only while glimpses and silhouettes of the characters are shown in subtle actions on the screen.) 

He gives an introduction to the background of the family involved in 

V the drama, arousing the curiosity of the audience and retaining the suspense of the happenings that will take place this Saturday 

V V morning.) S-j i- - 2_ O.k. 
Sequence 2. (“DRUG SCENE”) 
(In Kiran’s room with simple, scanty furniture and generally neglected and untidy. Low eerie music fn the back-ground. Lights are dim. Neil is sitting on the bed with a cigarette and an alcoholic drink in a glass. Some syringes, drug powder etc. on a stool. Kiran is also there, sitting on a chair, puffing away oblivious of anything else. They are in the act of injecting themselves on their arms when Niki suddenly walks in through the door.) 

NEIL: Oh, that’s great! Kiran, I feel good aireadyl 

VKIRAN: (laughs in high spirits) Neil, didn’t I tell you so? It makes me forget all my vrries. 

NEIL YOu can say that again Kiran. Look what I’ve been through. Sincemy mother died, I have felt so alone. Dad never had enough time for me. My step-mother has never shown any motherly affection towards me V 
KIRAN: Come-on Neil, forget these sob stories. That’s why I 

always invite you over to drown your misery in this (points to glass 

of alcohol) 

NEIL: Last night, Kiran, I had to stay here with you. I couldn’t have faced my Dad after knowing how badly I have flunked my final university exams. What am I going to do, Kiran? 

KIRAN: Ahh.... Don’t give a damn Neil.... here take a puff! You can always repeat the year, can’t you? 
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NEIL: (taking a puff) Kiran you don’t understand! What will I do when Niki, my fiancee finds out about all this (points to the alcohol and the drugs) She is one person who has shown some concern for me. Yes! She loves me. Since our engagement she’s literally worshipped me. She thinks I am her ideal. If ever she found out the truth... I’m sure she will want nothing to do with me again . .and.. I oh.... I’d kill myself! 
KIR.AN: Don’t be funny, yaar. Stop this non-sense and self pity. Can’t you forget Niki for now Forget it all Just enjoy the present life!! 

(A knock at the door) 

KIRAN: Who could that be? (slurred speech) 
NEIL: Who cares! Here give me that drink again. / ,,_NN 
(Kiran gives him the glass) // 
(Louder knocking at the door) \ ( 
KIRAN: Okay, Okay, I’ll get it. (Gets up, almost falls and staggers to th J 
door. He opens the door) 

KIRAN and who are you? (sleazy look) 

(Niki looks at Kiran, is shocked, shoves him aside and moves towatds-Neil. She is stunned and very angry indeed.) 

Niki: Kiran! 

Kiran: Niki! 

NIKI: (shocked and angry) Neil, you’ve been drinking again? Oh my God, Neil! Do you realise I’ve been looking for you the whole of yesterday. Your results ware out and I wanted to see you badly. I guessed you uld be holed up here! 

(Looks at the alcohol, syringes etc. and is flabbergasted) 

NIKI: What are you up to Neil? You.... you.. on drugs’ 

KIRAN: Sh. . . .Sh... don’t make a fuss! We are enjoying ourselves’ 
(Walks back to his original place on the chair) 

NlKl: Neil, stop it for God’s sake! 

(Turns to Kiran) 

So, this is what you two have been doing all this time! You ware always pretending to everybody that you two study together her& Your secret is out now! 

NIKI: (To Neil) Please Neil, Stop this now! Don’t you know you are ruining yourself? Problems never get solved with drugs! (Tries to snatch the syringe from his hand but in vain) 

 

 

NEIL: (already a bit high.. . laughs) Oh Niki, my dear, stop lecturing! This is 

the real life... come... come... try it yourself! 7’ 
NIKI: (trying her best to be patient) Neil, don’t you know that I love you. I care for you. We are engaged, we were supposed to marry soon. What’s come over you? I thought you were my friend. I loved you with all my 1 heart! This is the most dreadful disillusion of my life... .1 thought you had such high morals and exemplary virtues. 
NEIL: Virtues! High morals! 

(laughs hysterically and kicks a stool nearby, making everything fall on the floor) 

Cut it out! Don’t give me any more crap woman! It’s all hypocrisy! You know very well how my parents have neglected me for their own personal businesses and misunderstandings. And yes, I’ve flunked those damned exams, so what? What’s there left for me in this cruel world and. anyway THIS... THIS.... (points to the drug powder etc.) is my solace, my own world.... 

NIKI: (very emotional with tears in her eyes) Very well Neill Stay in your world alone. I will not be part of it. Good-bye, good-bye for ever and here is your damned ring’ You cheat, double-faced punk! You junky - I hate you, I hate you! 

4 

(She holds him from the shoulders and shakes him thoroughly, then removes the ring from her finger and throws it at his face. Neil holds her wrist and twists her arm to hurt her. After a bit of a tussle, Niki manages to free herself and storms out of the room. On the way out she smashes a vase onto the floor, breaking it.) 

Niki: It’s all over Go to hell!! 

NEIL: (Laughs hysterically and starts giving himself another shot) Yeah, Yeah! (sarcastic tone) Go, go ahead dump me even you can abandon me.... Nobody has really cared for me anyway!? 

Niki leaves the room banging the door behind her. 

KIRAN: Yeah, let her go yaar’ Women! Who needs them’ Here take another shot! 

(Both Neil and Kiran begin drinking profusely and start injecting themselves with some drugs, finally staggering onto the floor. Stage darkened, end of this scene) 
 

— 
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Sequence 3 

(A living room with trendy furniture, carpets, lamps, wall hangings, clock, a music system telephone, dining / coffee table etc. 

Shabbo almost ready to go out, is manicuring her nails. She is humming an original song and trying to relax, blowing at her nail varnish and enjoying herself. 

Tanya comes in with a letter from her school.) 

TANYA: (Holds the mother’s shoulder but Shabbo shrugs her off) Mum, Hi! You are looking ‘fab’ as usual. Are you getting ready for the Parent’s Meeting at my school today morning? I came to remind you that Dad and you must be there at 11. 

SHABBO: (curtly) Listen Tanya, I am getting ready for my Kitty party today. I have to go to Linda’s place at 11. Sorry child! I cannot make it to your school. 
TANYA: But Mum, everybody’s parents come to discuss their children’s progress with the teachers. You people never come for any of my school functions! 

SHABBO: Oh stop whining all the time. I’ve already told you I cannot make it to your school today. Why don’t you ask your Dad to go? I wanted to talk to him last night but he came in so late from some meeting and now he’s already out jogging! 

Anyway, I had asked you to bake a cake for tea, have you done it? 

Sequence 4 

(Chand enters, in a jogging suit, ruffled hair and towel in hand. Panting a little, stretches and starts looking for his spectacles and the newspaper) 

TANYA: Yes, Mum, I’ve already put it in the oven. But, my parents’ meeting, Mum 

Chand: (to Tanya) How is my Tanya today? 

Tanya: Fine, Dad. How was your jog? 

Chand: Oh, it was long and tiring, as usual! 

Tanya: (in a haughty tone) Dad, It’s my parents’ meeting today. I always get embarrassed when the teachers ask me why my parents never come for any of my school occasions. 
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(Chand has settled on a chair) 

C HAND: Shabbo, honey, why don’t you attend Tanya’s school function? 

(Tanya starts making tea for the parents 

SHABBO: Oh I’ve to go for my kitty party at 11. 
(checking watch) I mustn’t be late. 

CHAND: (looking at newspaper) Since when this punctuality. From your life style, I would have thought there is no hurry in Africa - and - kitty party! You women! I don’t understand what you do at these Kitty parties - sit and gossip over pastries and samosas, and shred some poor husband to pieces! 

tch.. tch - utter waste of time 

SHABBO: (laughing and looking into a mirror) 

Come on Chand, as if you men don’t ever waste time - like when you are glued to the T.V watching that wrestling - I should call it bone breaking! 

C HAND: (gets up and goes to the music system) 

Oh that is exercising - our eyes I and do you know sports is the microc osm of life 

SHABBO: Now don’t give me that rubbish.... 

(to Tanya) Tanya, don’t just stand there! Pour the tea for you Dad! 

Tanya: Yes Mum. 

Shabbo: (to Chand) 

And that reminds me - How come you came home so late, last night? Were you and your ‘friends’ enjoying at the ‘Mujra’ again? 

CHAND: (angry, gets up as if to slap her but controls himself in time) How dare you say such a thing infront of Tanya! I told you I had a meeting at the office - there is a very important project going on. I don’t know why you have such a suspicious mind. Why can’t you concentrate on your home and forget your silly ‘kitty’ parties! 

SHABBO: Well, aren’t you forgetting that you were the one who stopped me going to work in the first place! What should I do in the house the whole day ? It gets so boring. I have to get out of the house. That’s why I keep myself busy with my ‘silly’ kitty parties. 

CHAND: Why can’t you do something more constructive? 
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SHABBO: My job was constructive, Chand, but you ruined my career. (mimicking him) 

“I don’t need your money “you said . You never wanted me to keep my individuality. You always wanted me to live in your shadow. Now you want me to stop having the little social life that I have .(fuming) 

CHAND: Social life! Shabbo you should be giving more quality time to the children. They need you. I keep telling you this but it falls on deaf ears... 

Tanya (Disgusted) There you go again! I cant stand these arguments all the time? I’ll go check on my cake. 

(Tanya exits) 

SHABBO: They are old enough now. I cannot baby-sit YOUR children all the time. 

CHAND: (head on his hands) You know Shabbo, you intentionally ignore both Neil and Tanya. When Neil’s mother died he was very young and your neglect has turned Neil to an alien to this house. 

SHABBO: Now don’t you start talking to me about that woman. You can’t get her off your mind, can you? 

CHAND: Oh, come on, Shabbo! You don’t have to feel this way. You know, 4 I love you. I am just worried about Neil’s frequent absence from the house. 

He’s hardly ever around. Even last night, he didn’t come home. I just wonder what he is up to! 

SHABBO: (laughing scornfully) Poor Papa, missing his 20 year old baby, is he? Well, since he got engaged to sweet Niki, he doesn’t have time for you. He must be with her most of the time! 

CHAND: (to Shabbo) 

and my Tanya.... she is always looking up to you for motherly affection. Do you give her any attention? I’m sure, you wouldn’t treat her like this if she were your own daughter. 

SHABBO: (Angry tone) 

Go on! Blame me.... blame me for everything that goes wrong in the house! What about yourself? Chand, how much time do you give to your kids? You are always on site or attending some meetings. The children are also your responsibility! Don’t pass the buck onto me all the time! And that reminds me... .you go for your Tanya’s parents’ meeting today! 
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(The phone rings. Chand waits for Shabbo to pick it, but she ignores it. C hand has to get up and take the phone) 

CHAND: Hello? 

Yes, Chand here (pause) 

Yes, David, what is it (pause) 

What , today on a Saturday? (irritated) OK. OK. I’ll be there. 

(He puts the phone down and turns to Shabbo.) 

CHAND: Shabbo! It’s going to be impossible for me to go to Tanya’s school. I have to be on site by 12. There is another urgent engineers’ meeting. It had to come up today! Shabbo, just get my clothes organised. 

SHABBO: (Still angry. Keeps sitting) 

You can get your things yourself! The maid is not around today. You know, she’s gone for her mother’s funeral. I don’t think she’ll be back till next week. Oh, I don’t know how I’m going to manage. That’s why I’m always telling you 

- we need two house-maids. 

CHAND: (has poured himself another cup of tea and is sitting at the dining- table) 

There you start again - always complaining , for ever wanting more, tell me! 

•Wht don’t you have - lovely kids, a new car, a spacious house - what more do you want? 

SHABBO:( Starts counting on her fingers) Well another maid for starters, our own swimming poo’ ,.. my personal Jacuzzi. 

Sequence 5 

Enter Grandma. Stands quietly and listens to the argument going on. She has a horrified look on her face! 

CHAND: Greed, greed ... and false prestige - that’s what I call it. You have no limits to your wants and desires. Just think of those unlucky ones, who don’t even get one square meal a day - forget about a roof above their heads. I bet the cost of one swimming-pool could feed a thousand hungry mouths for a whole year! (Gets up and walks to his brief-case) 

SHABBO: Hhmmph! Oh you and your philosophy of compassion. (With exasperation, starts arranging some flowers fl a vase) 
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GRANDMA: toba!’ My God! Arguments early in the morning! When is this household ever going to have a peaceful day? I pray day and night for your welfare but God help you! Chand... 

Chand: Yes Ma. 

Grandma: Chan&betay did you see or talk to Neil at all last night? I’m worried about him. He seems to keep away from the house too often. Shabbo, did you see him? 

Shabbo: I keep busy. I don’t know anything about him. 

Grandma: hun... busy and would it be asking you too much to avoid these ealy morning arguments? When are you going to start setting good examples to your growing teen-aged children? 

SHABBO: Oh, spare me from you usual “holier-than-thou” attitude. Please! Stop interfering. 

GRANDMA: Yes, you can say I am always interfering but how can I ignore the happenings under one roof? You two are always busy or at daggers with each other, even in front of the children. The mother-less Neil and Tanya are always being ignored and neglected and you Shabbo... are always pampering your own Vicky. It’s not fair, Shabbo! If you really loved Chand you would treat all the children equally! 

SHABBO: (to Chand) Chand! Tell her to stop provoking me. Her sermons make me sick. She always preaches that ‘bahus’ are like your own daughters, but, does she treat me like her own? She’s always finding faults and criticising me all the time! Sometimes, I wish I could just go away somew here else. Chand, if I decide to leave this house, it will be all because of this woman! (almost crying) 

GRANDMA: (to Chand) (very emotional) Hun, hun, Tantrums! See..., see .... betay, how she talks to me! As your mother don’t I have any right to point out wrong doings going on in this household? I would never want this household to break apart. I just wish you would all live together more harmoniously. 

CHAND: Ma, Ma, please calm down. I have so many other things on my mind. Take it eas’. Everything will work out, I hope! Shabbo, you don’t have to answer back so rudely. She says things for our good, you know! 

SHABBO: Yeah, yeah, take her side, as usual - She’s always right and I’m always wrong. How these mothers monipulate their sons! 

GRANDMA: Toba, toba. God help us!! 

(andma adjusts hec”dupatta on her head and walks out, muttering under her breath) 

 

 

Sequence 6 

(Enter Vicky with ear phones and a walk-man, shaking with the rhythm of the music, walks past parents without acknowledging their presence. He stops near the music system.) 

CHAND: (removing glasses, he snaps his fingers in front of Vicky) Morning Vicky! Isn’t everybody up early today? 

Shabbo gestures to Vicky to make the music low. Vicky comes to the Father and Mother. He has removed his ear-phones. 

Vicky: Hi Dad, Hi Mum! 

Chand: Any plans up your sleeve? 

VICKY: Hey, I’m so excited today I’m going to this new club. I am attending a party at the ‘Moto-Moto’ club to-night. 

CHAND: Vicky, you are always going for parties on your own. Why don’t you include Neil in your activities? You know it well enough that he prefers staying aloof but I think you should try to be a friend to him rather then just a younger brother. 

4 SHABBO: Oh, my Vicky is so self confident; he makes friends so easily. It’s Neil who always seems confused. Sometimes I feel he acts quite impulsive and fickle. He is so secretive, too. In my opinion he has a disturbed personality! 

VICKY: Come on Mom Neil’s really cool. He’s been really slogging hard for his finals with his friend Kiran. His exam, results were supposed to be out yesterday. But he never came home last night, so I wonder how he fared. (changing the subject) 

Anyway, Dad, can I have some cash for to-night? 

CHAND: What? Again? This is the second time this week. Where do you spend all this money, by the way? 

(Vicky ignores the question) 

CHAND: (Takes wallet out of his pocket) 

Any way, how much do you want today? 

VICKY: (avoiding Father’s eyes) Just five thousand. 

CHAND: What! Five thousand! That’s too much! 

(Puts wallet back without giving him anything.) 
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VICKY: But Dad. I need it. All the other guys are gonna be 

there in the evening and they always have enough money to burn. I don’t want to look miserly in front of them. I want to have real fun! I want to look cool! 

CHAND: (glaring) I don’t think highly of your “other” guys. They always look and behave as if they are high. I’m sure they are into drugs. What do they call them these days - Smarties. Disco BiscuitsH 

SHABBO: There you go again! Whenever he wants to go out with his friends you start harping about drugs and alcohol. 

(walks to Vicky and pats him) My Vicky is not like that. Have you ever enquired from Neil where he spends most of his time and your money? Come on, Chand, let Vicky, too, have a good time. You are young only once, give him the money! 

CHAND: Shabbo, Shabbo. It is not a question of money - it’s the principle that matters. He is provided with everything in this house - what does he need extra cash for? Don’t you know, the more 

money youngsters have the more venues they discover to squander it. And isn’t he supposed to be concentrating on his studies to pass this time? I still haven’t compromised with his repeating his ‘0’ levels!! 

VICKY: Oh chill out Dad, calm down. It’s no big deal. I ‘m sure to sail through this time. You’ll see.... (walking with cereal bowl towards side bar) 

C HAND: (disgusted, walking out of the room. He has taken his jacket and 

towel and put it around his neck. Reaches near the door) 

I am always making you children aware of your responsibilities and priorities. 

The rest is up to you It is a question of your own lives after all. 

(to Shabbo) 

I have to get ready for my meeting. Shabbo, you can deal with him! 

(Chand leaves the room.) 

 

 

Sequence 7 

SHABBO: (to son) Take it easy Vicky. Your Dad means no harm. I would hate to see you go astray. 

(puts her arms around her son) 

VICKY: (angry) Yeah, yeah. I know that but, Mom, I don’t like 
him breathing down my neck 
(speaking under his breath -mumbling) 

He’s such a grouch sometimes! God!! 

SHABBO: Buus, buus You don’t have to be rude. Here’s some money 

(removes it from her purse). 

Make do with it! 

(going out) 

Oh, I still have to do my hair - (Shabbo rushes out of the room. Vicky puts 

the money in his pocket but is not so happy) 

Sequence 8 

(Vicky sighs deeply. Then he walks to the music system, changes the C.D. and starts dancing with the loud music, oblivious of anything else. Disco effects, coloured lights etc.) 

VICKY: Oh, this music takes me to another world. 

(He goes into a trance) 
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Sequence 9 

(Tanya walks in carrying a cake in a plate. She puts it down on the coffee table, mimics Vicky a bit and then switches off the music to bring him down to earth and get his attention. The imaginary boys and girls have disappeared. The atmosphere is the same as before.) 

TANYA: (cheekily) 

Vicky, Vicky! Can’t we have some peace and quiet here! 

VICKY: And what’s bugging you, Tanny baby? 

TANYA: Oh, don’t call me a ‘baby’. I hate it! The grown-ups in this house are always behaving more childishly and immature than us kids! 

VICKY: Ah, take it easy, sis. Life is too short to bother about petty squabbles and arguments. Hey, did Neil come home last night? 

Tanya: I don’t think so! 

Vicky: I worry about Neil. I wonder what he is up to! 

TANYA: Yeah, I don’t believe that Kiran and he spend all that time studying together. I bet they are up to no good! 

4 (changes the subject) 

Anyway, here try some cake. I made it! 

(cuts a slice and offers it to him. Licks off some cream herself, too) 

VICKY: A fine way to finish me off, eh? 

TANYA: Of course not, silly. If I wanted to do that, I would just push you over your stupid boots! 

VICKY: Then why are you always trying your new recipes on me? Have it yourself! Put on some more fat, as if you don’t have 

enough already. 

TANYA: What! Fat! ME! (walks around him) 

Look at yourself - look at your hair - as if a lawn-mower has gone hay-wire! 

Look at your ear-ring — getting familiar with your feminine side eh? 

(Really angry - throws the newspaper (or cake) at him. 

VICKY: Oh stop it and shut up you fatty, fatty bumbola! 
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TANYA: Shut up yourself, you brute... wait till I tell Dad about those ‘porno’ magazines hidden under your mattress and those cigarettes 

VICKY: You, you deviL. .tell-tale... you’ve been going through my things again! I’ve told you to keep away from my room and 

mind your own business !! Fat Witch!!! 

(moving as if to strangle her) 

Sequence 10 

(Grandmother walks in, disgusted at the din. She is in salwar-kameez and the dupatta is on her head) 

GRANDMA: Toba, Toba! What on earth is happening here? 

Vicky betay, stop teasing her. I’ve told you so many times before not to call her 

fatty. She is my delight, my beauty, call her by her lovely name Tanya - I named her myself 

(Tanya has run behind the grandma and makes faces at Vicky) 

TANYA: You see Dado, he’s always teasing me. He thinks he is a super 

man and he can get away with anything. Even Mom favours him all the time. 

He always gets his own way. Do you know he is going to that ‘Moto-Moto’ 

Club again. Dado, even I want to go too, please, please, ado 

GRANDMA: Oh ho. Slow down Tanya! “Moto-moto”! Toba, toba my child. What kind of evil name is that? That’s not a place for a decent girl to go to. 

TANYA: Why? If Vicky can go anywhere he wants to, why 

can’t I? Is it because he is a boy? Even I want to be ‘in’, not old fashioned and narrow-minded’ 

GRAN DMA: Now Tanya, don’t get too overclever! You know very well that we all love you both. It’s just that Vicky can look 

after himself and you - we don’t want you to get into any sort of trouble - we’d be doomed ... if something happened to our baby... We restrict you only 

because we CARE.. 
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TANYA: Oh, I feel suffocated here. I’m tired of being nagged - don’t do this, don’t wear that, don’t go out with him, don’t bring her home.... I wish you people uld trust me a bit more and care a bit less! 

(Vicky mimics her) 

GRANDMA: Less? Did you say less? We should care less? What are you saying child? Do you know what happens to those boys and girls who are not cared for? Tanya, you read magazines and newspapers - you should know more than me about child molestation, rape, teenage pregnancies, drug abuse, drunkenness and this new dreadful disease that I keep hearing about these days what is it called .... A.LD.S. ! 

TANYA: Dado, I know about all this - but.... I can look after myself. I am strong and confident! 

GRANDMA: Come, I want to share something with you. 

GRANDMA: I could have gone astray but I always kept in mind what your grandfather used to say, “Bib stick to high morals, respect family values, never be afraid of hard work, do what is right and always trust in God.” I want you also to remember this and appreciate the values of a virtuous life! 
My children, this is our true “Heritage” and I do not want you to ever forget that! 

(The children are sitting around their Grandma while she is 

reminiscing. Vicky could be drinking some juice etc. Grandma starts brushing and plaiting Tanya’s hair which was open before.) 

GRANDMA: (continues) Through my stitching, I managed to make ends meet with dignity. Even your father, Chand could have fallen 

• prey to peer pressure and ruined himself but with the grace of God, he did not falter and he is blessed today. Everybody respects him for his honesty and hard work. 

 

 

VICKY: (Having some juice) But Gran... when you guys were young - those were ancient times - those traditions and ways are irrelevant now - you never had what we have now - the media, TV. foreign movies, computers, inter-net - name it - we are exposed to all foreign values - and you guys are the ones who have introduced all this into our lives. The 21st century is around the corner, you can’t lock us up behind cages now! 

GRANDMA: Toba, toba! Who said anything about locking up? Limits my children - limits. You have all the freedom to pursue any career, any job - but character degradation,, we will not tolerate! I know today, life for the youth is harder than ever before. You are exposed to so muqh more temptation. But, why do you want to ape the negative aspects of foreign cultures? Ask yourself 
- where are you people going? What is the purpose of your life? Will this moral decadence ever end?? 

(Urgent knocking at the door.) 

TANYA Oh, I’m sick and tired of all this! Let me go and see who it is! 

(Tanya goes to get it.) 

Sequence 11 

VICKY: Who can that be? (Nibbling at some snacks) 

(Neil comes in looking weak and depressed, holding a result slip in his hand) 

TAA: (screaming) WhatI Oh my God! (expression of shock and horror) 

ViCKY: Oh Neil, waz-up? We missed you last night, bro. What happened about your results yesterday? 

(Neil staggers to the couch near the grandma) 

GRANDMA: Yes Neil betay, what’s wrong? Are you feeling all right? 
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NEIL: It’s over... Evehig . Everything is finished... I am fed up of this rife! (Hysterical, a bit unbalanced, appropriate actions and expressions. 
TANYA: What’s happened Neil. You look sick brother.. Were the results that bad? 

(Holds his hand) 

NEIL.. (Pushes Tanya away) 

It is the end for me, My results (trying to stand up) 

VICKY so I 
NEIL: I flunked.... the whole year’s slogging has gone down the 

drain. I am a good for nothing I .1 

(gives Vicky the result slip and feeling dizzy) 

Nobody can help me s Nobody loves me. 

(Vicky reads the result slip and comes close to Neil to console 

him) 

NEIL: Oh L.. .hate. . . .myself (pause) ...Niki Niki 

(Some symptoms- heart fluttering, jaw-clenching and teeth 

grinding) 

TANYA: 

... Niki, yourfiancee! 

What about her, where is she? 

What’s happened? 

NEIL: She . . .she broke off the engagement with me. 

(Hysterical) Here, Vicky - you can give her baâk this ring. 

VICKY. Now, calm down, big brother! We can talk this over. I’m sure Niki will come round. It’s just a misunderstanding. 

NEIL: No, no. She found out I know I could not have hidden this fact from her for ever., 

GRANDMA: ‘.. . Found out what, betay? 

= ::.. 
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NEIL that I am on drugsForgive me Grandma, I have fooled you and every-body else. it just started as a prank in school together pith Kiran. One thing led to another and I became addicted - I became so dependent that I couldn’t live without it. 
(Grandma and others are horrified) 

VICKY: But, how did Niki find out about it? 

NEIL: Today morning, she caught me in Kiran’s room while se re both giving ourselves the shots. Then hell broke lose 

(extremely emotional and hysterical) 

She threw the ring at my face, called me all sorts of names and left, barging the door on my face she doesn’t want to see me again. She told me to go to hell and I am..... I am.. 

GRANDMA:. O C’-L (. 
(Neil faints) What have you done to yourself? Speak up my child speak up! 

(Shakes him. Tanya brings a glass of water. Vicky holds Neil’s hand.) 

NEIL: I I I’ve taken an overdose of I’m going to die 

4 Let me die Nobody cares anyway 

(Faints. Symptoms like swaating, clenching etc.) 

Sequence 12 

TANYA: Don’t say that Neil. We all love you. We need you, my 

brother. Don’t leave us! 

(very emotional, starts crying and shouts) 

Mum, Dad? Hurry up? Come here quick’ Neil’s here? 

(Chand and Shabbo hurry in. Chand is in a suit now.) 

CHAND: What’s going on in here? Neil, my son, what have you done to yourself? 

(Sees Neil lying on the sçfa. Feels his pulse and shakes his head) 

 

VICKY: (Panic) He’s taken an over-dose! 
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TANYA: (Crying) 

Niki’s ditched him! He’s also flunked his exams. 

GRANDMA: 0 my God! This curse was bound to fall on this 

trouble-ridden household. 

(starts wiping tears from her eyes) 

0 God help my child, my poor, sensitive lad! 

Shabbo: What is it Chand? Are you sure he is not pretending? 

Chand: Stop it woman! His pulse is hardly there and you are saying he is pretending. 

Shabbo: How should I know! Hun... hardly any pulse! What! 

Chand: Stop panicking. His condition is critical. We must get him to the hospital as soon as possible. There is no time to waste! He could drift into a coma or even die! We couls lose our Neil for ever!! 

Vicky: Neil, don’t leave us my brother.... don’t do this to us Neil don’t go 

Sequence 13 

(They all gather around unconscious Neil on the verge of carrying him out. The scene freezes here. The siren of ambulance can be heard in the distance. Tragic (death) music in the background. Only the Grandmother comes to the front of the room. In a pensive mood and Very sad indeed.) 

The grandmother’s tearful and very emotional voice echoes: 

Neil is just one of the many victims of troubled house-holds and the tribulations and frustrations of modem living. We as parents and as a society have a duty- to set good examples, give the right guidance and to channel the growing minds of the youth towards making the right decisions in spite of the temptations which in many forms have been and will always be there.” 
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Sequence 14 
: ::j Conclusion (ok 
Ihe Grandmother continues 

Be not engrossed lr’i things ephemeral, * 
To the neglect of higher things in life. 

Life is but short and death will soon. ctaim you. 
Oh that men would only learn, 
before it is too late, 

the serious issues of the higher life! 

They must taste the consequences of their neglect. For evry good enjoyed, they must 

In the hereafter give a strict account..’” 

-TilE 

‘Sura Takathur (Piling up) from The Holy Quran. 

Translation commentary -Abdullah Yusuf A! i c.282.Pg.1777..cii 1-8 
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